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Overview 

Four things that make reading and writing easier: 

1. Listen instead of reading or while reading 

2. Enlarge text and reduce distractions 

3. Outline and navigate documents when reading and writing 

4. Dictate instead of writing 

Five free technologies that can help everybody improve 
reading and writing: 

1. Read Aloud in Microsoft Edge and Office Apps 

2. Immersive reader in Microsoft Edge and Office to remove distractions  

3. Outlining with Navigation Pane in Microsoft Word  

4. Planning with outliners and mind mapping tools 

5. Dictate in Microsoft Office, Windows and Voice Typing in Google Docs 

Disclaimer 

This is a general guide. If you are registered with a disability support service 

and qualify for funding for assistive technologies, you need to contact them 

first before making any purchases. 

What makes reading and writing easier 

1. Listen: Read with your ears 

Listening to improve reading 

Listening to text has several advantages: 

1. Helps people who are slower readers to read faster  

2. Reduces eye strain  

3. Improves understanding 

There are two ways to listen: 

1. Listen while following on the screen 

2. Listen without reading as in an audio book or a podcast 

Listening to improve writing 

Listening to text is also a very useful part of the writing process. When you 

listen to what you wrote, you will notice many more issues with your text 

than just by reading it again and again. for example: 

• Missing words 

• Repeated words 
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• Unfinished sentences 

• Awkward phrasing 

• Typos not picked up by the spell check 

How to make the most out of listening to text (reading with your 
ears) 

1. Learn the controls for pausing and skipping back and forth 

2. Learn how to switch between different voices 

3. Learn how to control the speed of playback (many people prefer to 

listen at higher speed but it is also possible to slow playback down) 

4. Switch between listening only and listening while reading to improve 

your comprehension and processing skills 

5. Listen on your mobile device while on the go or doing chores 

6. When listening to PDFs of academic articles, crop the pages to 

remove headers and footers; this will avoid distracting interruptions 

while listening 

2. Enlarge: Speed up your reading 

The smaller the font, the more effort he will have to spend on decoding it. 

There are three things that will speed up your reading and also reduce eye 

strain, and mental effort. 

1. Large font 

2. More space between lines 

3. Shorter lines 

Many people make the mistake of trying to fit the whole page on the screen. 

But scrolling or turning the page takes much less effort than decoding what's 

written on it. 

3. Outline and navigate: See the bigger picture of your text 

Using outlines for reading 

Often, you may want to see the bigger picture; how the paragraph you are 

reading fits into the overall text. You should try to discover the outline and 

navigate through the text using this. 

Understanding the outline of the text you are reading can also help you read 

more strategically. You don't always have to read every document from 

beginning to end. Here are some useful strategies that can help you read a 

complicated document more quickly and understand it better: 

• skip to the conclusion section and then return to the beginning 

• read all the headings in the document to get a sense of what it contains 
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• read the first lines of all paragraphs first to get a sense of where to 

focus your energy  

• find all the lists in the document and read them first 

• if the document does not have sections, mark them yourself to help 

you understand it better 

Outlining for understanding with mind maps 

You can also use outlining to help you understand what you are reading. Take 

notes in a structured way to help you understand the relationships between 

parts of the text. 

Mind maps as graphical outlines 

Many people like to display their outlines graphically in the form of a mind 

map. Mind maps make it easier to see the whole picture at once. But they 

may not contain as much information as an outline structured as a list. 

Most software makes it possible to convert between a mind map and a list 

outline. 

Concept maps for deep dives into ideas 

An even more powerful way of understanding difficult concepts is a concept 

map.  

Unlike a mind map, which is just a graphical outline, the concept map labels 

connections between ideas and makes it possible to link them in more 

complicated ways. 

Concept maps also don’t have one starting place. You can follow the flow of 

an idea in any direction. They fulfil a different role from a mind map in the 

learning process. 

It takes more effort to create a concept map because you have to focus on 

the nature of the relationships between concepts. But concept maps have 

been shown to be an effective tool for improving understanding. 
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Using outlines for writing 

Outlining is also an essential part of writing. You don't always have to start 

with an outline, but at some point you should create one. This will help you 

get a better sense of how the different parts of what you're writing fit together. 

If your outline is marked with headings, you can also use it to navigate 

around the document and even change its structure. 

Outlining skills 

Many people find outlines a very natural way of organising their thoughts on 

paper. However, others prefer to think in larger chunks of text and sometimes 

struggle to create an outline. Both approaches are important when reading 

and writing. If you find you struggle with creating outlines, try to use these 

three steps to develop your outlining skills: 

1. Brainstorm: Write down 

a. What you know already 

b. What do you want to know / do 

c. What are common questions others ask 

2. Chunk: Put things on your list that belong together into groups 

3. Structure: Organise the chunks into a hierarchy 

a. What are the top line ideas 

b. What are the elaborations 

4. Dictate: Save your hands and improve spelling 

Reasons to dictate 

Dictation technology has improved so that it is now highly usable by most 

people without much effort. There are several reasons why you may want to 

consider dictation: 

1. Reduce the strain on your hands 
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2. Improve your spelling (reduce the effort it takes to remember more 

complicated words) 

3. Make it easier to formulate complex thoughts in your head before 

writing them down 

Dictation skills 

1. Speak in complete sentences rather than individual words 

2. Learn to formulate sentences in your head before saying them 

3. Listen to the text after you dictate it 

Dictation limitations 

While dictation technology has become very usable and powerful, it is still far 

from perfect. You should always carefully review what you dictated. Listening 

to what you dictated while following along with your eyes will produce the best 

results. 

Most of this document was created using dictation and edited with the 

assistance of read aloud features. 

 

Five free technologies to support reading and 
writing 

1. Read Aloud in Microsoft Edge and Office Apps 

New natural voices 

Microsoft has introduced new high quality natural sounding voices in multiple 

languages. They are available across various applications and devices but 

require an online connection. 

Look for the Read Aloud feature in Microsoft Office. 

Note: You should use Microsoft Office 365 to get all the latest features. They 

are also available in the online apps and mobile apps. 

Microsoft Edge to listen to Web pages or PDFs 

You can use the free Microsoft Edge browser to read both web pages and 

PDFs. You can access this in many ways: 

1. Click on the Read Aloud button in the URL bar 

2. Go to menu and choose Read Aloud to listen to the whole page 

3. Select any text, right-click and choose Read Aloud Selection 

4. Use the Ctrl-Shift-U keyboard shortcut 
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Once you start listening, a menu bar will appear at the top. You can use it 

to: 

1. Play/Pause 

2. Skip back and forth by a sentence 

3. Change Voice Options 

a. Voice (prefer Natural voice when available) 

b. Speed of reading 

Microsoft Word to listen to documents 

You can access Read Aloud in Microsoft Word in one of two ways: 

1. Click on Review tab and choose Read Aloud 

2. Use the Ctrl-Alt-space keyboard shortcut 

Microsoft Outlook to listen to messages 

In Outlook, you can listen to: 

1. Messages you received 

2. Messages you typed before sending them 

To launch Read Aloud in Outlook, you can either: 

1. Use the Read Aloud button which is either in: 

a. Messages you received: Under three dots at the end of the Tool 

bar 

b. Messages you typed: under the Review tab 

2. Use the Ctrl-Alt-space keyboard shortcut anywhere 
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2. Immersive reader in Microsoft Edge and Office 

What is Immersive Reader 

Immersive Reader is a feature introduced by Microsoft that will enable more 

productive reading in a number of applications. It will: 

1. Remove distractions from web pages (Edge only) 

2. Allow larger font and increase space between characters 

3. Line focus 

4. Syllabification 

5. Highlighting of parts of speech (Edge and Onenote only) 

6. Read Aloud (can work outside Immersive Reader, as well)  

Immersive Reader is available across most Microsoft applications. However, 

the features and interface are not always the same. 

  

Original display of web page Display in Immersive reader 

 

Microsoft Office: Word, Outlook, Onenote, Teams 

Immersive Reader is built into the key Microsoft Office applications used for 

dealing with large amounts of text. 

• Microsoft Word 

• Microsoft Word Online 

• OneNote 

• Outlook 

• Teams Chat 

It has a slightly different interface across different applications. 

To launch it, click on the Immersive Reader  button under the View tab. 
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Application Interface differences Feature differences 

Word 

 

No parts of speech 
highlighting 

Outlook 
 

No parts of speech 
highlighting 

OneNote 

 

• No column width 

• Read aloud button 
at the bottom 

Word Online Same interface as Onenote • Same features as 
OneNote 

• Opens with 
increased font 
spacing by default 

• Does not remember 
settings across 
sessions 

Teams chat Same as Onenote Same as Onenote 

Microsoft Edge 

The main purpose of Immersive Reader on Microsoft Edge is to simplify the 

reading of complex web pages. By default, it only works on pages with 

articles, not on lists. However, it is possible to select any text on any page and 

display it in Immersive Reader. 

There are three ways to launch Immersive Reader: 

1. Click on the Immersive Reader icon in the URL bar 

 
2. Type the keyboard shortcut F9 

3. Select any text, right click and choose Open selection in Immersive 

Reader 

To close Immersive Reader, you can either: 

• Click on the Immersive Reader icon in the URL bar again 

• Type the keyboard shortcut F9 

Note: Immersive Reader only works on web content, not PDFs. 
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Alternative for PDFs: Adobe Acrobat Fluid mode for PDFs on 
Mobile  

Unfortunately, there is no reliable way to read PDFs in an Immersive Reader 

style mode. Some PDF reading applications offer reflow mode that allows the 

reader to enlarge text without having to scroll left to right but the quality is 

variable. 

However, it is now possible to achieve a similar experience on mobile devices 

with Adobe Acrobat reader app using its Liquid mode feature. It uses a 

machine learning algorithm to transform the PDF into a more readable format 

and to create an outline. 

 

Original 2 column 
document 

Document in 
LiquidMode 

Automatically 
generated outline 

   

 

Liquid mode in Acrobat Reader has several limitations: 

• it requires an online connection 

• it does not work on some very complex documents 

• it does not work on very long documents 

• it does not allow highlighting 

• read aloud feature built into Acrobat Reader doesn't work in this mode 

 



Page 11 of 23 

3. Outlining with Navigation Pane in Microsoft Word 

Microsoft Word is the primary document creation tool for academic writing, 

reports and draft web pages. Also, many people like to take notes in their 

Word document. 

All of these activities benefit from a robust outlining system. It is very easy to 

create, manage, and navigate by an outline within Microsoft Word using two 

powerful but underappreciated features: 

1. Heading styles 

2. Navigation pane 

An equivalent to these features can be found in most other word processing 

software. 

Headings styles 

To take advantage of the outlining features in Word, you have to mark all 

section headings with Heading styles. Doing this will enable the automatic 

creation of Table of Contents as well as the Navigation Pane. It also has the 

added benefit of making the document accessible for blind readers using a 

screen reader. 

What are styles: Every paragraph in Word has a style which is set to Normal 

by default. A style contains information about formatting of the paragraph such 

as, font size, line spacing, indentation, etc. You can change the style from the 

Styles section on the Home tab.  

There are nine built-in styles called Heading 1-9. Each number represents 

the level in the outline. 

There are three ways in which you can mark a section heading with a style: 

1. Click anywhere in the text of the heading, and then click on Heading 1, 

2, 3, or 4 in the Styles section on the home tab  

2. Use a keyboard shortcut: 

a. You can choose a keyboard shortcut to choose the number of the 

heading level directly: Ctrl-Alt-1, Ctrl-Alt-2, Ctrl-Alt-3, etc. 

b. You can promote or demote the level of the heading of the 

paragraph you are with the keyboard shortcut: Alt-Shift-Left 

Arrow or Alt-Shift-Right Arrow 
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Navigation pane 

Microsoft Word has a feature called Navigation Pane that shows all the 

headings in the document. You can use it to manage the document outline: 

• Collapse sections or subsections 

• Only show sections at a certain level of the outline 

• Promote or demote selected sections in the outline (this will change the 

heading levels of all subheadings) 

• Select the heading and all the text in subsections belonging to it 

• Drag and move sections up and down in the outline (only in Microsoft 

Word on Windows) 

How to use the Navigation Pane: 

1. To open the Navigation Pane click on the View tab. 

 
2. To access the main features of the Navigation Pane right click 

anywhere inside it. 

 

Other advantages to using Heading styles 

If you've marked all your section headings with Heading styles, you can also: 

• create an automatic table of contents based on headings 

• export the document into PDF with a clickable table of contents and 

headings as bookmarks 

• change the font style, size, colour and other formatting by redefining 

the style to ensure consistency across the whole document 
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Marking headings with styles is also necessary for accessibility.  

Overall, using styles has many advantages and makes it worth the investment 

into learning how to use them. 

Alternatives: Google Docs 

Heading styles are also available in Google Docs with many of the same 

features including a Navigation Pane called Document Outline and keyboard 

shortcuts. 

However, it is not nearly as full featured as what is available in Microsoft 

Word. The only features available are: 

• Use keyboard shortcuts to mark section headings with Heading styles 

(Ctrl-Alt-1, 2, 3) 

• Show document outline  

• Generate automatic table of contents 

• Change the formatting of headings at different levels 

4. Outlining and Mind mapping Tools 

For more sophisticated outlining, you should consider using a dedicated 

outlining tool. There are options of both free and paid software for this. There 

are two types of outlining tools: 

1. Outliners: Display outline as a list of headings and subheadings 

2. Mind maps: Display outline visually as branches from a central field 

Mind maps can be converted into outlines and vice versa.  

 

Mind map and outline display of the same list 
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Features to look for in an outlining tool 

Most outlining and mind-mapping tools should have these features: 

• Use keyboard shortcuts to quickly generate new items and move 

items around; typical keyboard shortcuts are: 

o Enter: Create new item 

o TAB: Move item down one level in the outline 

o Shift TAB: Move item up one level in the outline 

• Collapse and expand levels of the outline 

• Export the outline into a word processing application or presentation 

Many mind-mapping and outlining tools also have these additional features: 

• add images and/icons to items in outlines 

• make checklists 

• add dates to items on outlines and display them as timelines (this can 

be used for efficient project management) 

• collaborate and/or share outlines or maps online 

Outliners 

There are many free and professional outlining tools available, these three all 

offer sufficient free features for most uses: 

1. Checkvist: Fully online tool  

2. Dynalist:  Online tool with associated apps for most platforms 

3. Obsidian: Note taking app with strong outlining features  

Mind Mapping Tools 

There are dozens of free and commercial mind mapping tools available at all 

kinds of price ranges. Free or inexpensive my mapping tools will be sufficient 

for most needs. These four represent major types: 

1. XMind 8 (Classic): Free tier of a powerful mind mapping tool for all 

platforms. 

2. Mindomo: Online mind mapping tool with an outline view with apps for 

desktop and mobile (free for three maps with a low monthly 

subscription). 

3. Free Mind: Entirely free basic mind mapping tool for desktop. 

4. WriteMapper: Paid mind mapping and outlining tool focused on 

creating long documents. 

https://checkvist.com/
https://dynalist.io/
https://obsidian.md/
https://www.xmind.net/xmind8-pro/
https://www.mindomo.com/
http://freemind.sourceforge.net/wiki/index.php/Main_Page
https://writemapper.com/
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How to make the most out of using outlining tools 

To take advantage of the power of outlining and mind mapping tools, you 

should spend time learning to use them more fluently and productively. You 

should especially focus on: 

• Learn the keyboard shortcuts for fluent creation of outlines to remove 

the barrier between the brain and the screen 

• Become proficient in moving between different levels of the outline 

• Develop a workflow of moving information between the mind map and 

your documents or notes 

Concept mapping tools 

There are not nearly as many tools available for creating concept maps as 

there are for mind maps. If you want to create a concept map, you should 

consider one of these two tools: 

1. CMap: Free dedicated tool for creating concept maps (works online and 

on desktop) 

2. Mindomo: Primarily a mind mapping tool and outline tool with concept 

mapping functionality 

5. Dictate in Microsoft Office, Windows, Mac and Voice 
Typing in Google Docs 

Key features of modern speech recognition 

Dictation is now available for free in all major word processors and on both 

mobile and desktop operating systems. The key features of modern dictation 

are: 

• Positives 

o Does not require training 

o Is responsive to all types of voices and tolerant of accents 

o Does not require special headset or microphone 

o Supports multiple languages 

o Does not have to be installed 

o Is free 

• Negatives 

o Requires an online connection 

o Cannot create custom vocabularies or adapts to individual users 

o Has limited editing capabilities 

o Expects input in complete sentences 

o What is dictated can change as more input comes in 

These pros and cons applied to all the systems described below, they do not 

apply to the only commercial alternative Dragon. 

https://cmap.ihmc.us/
https://www.mindomo.com/
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Microsoft Office: Word, Outlook PowerPoint 

Where is it available 

All new versions of Microsoft Office now support dictation when you are 

connected to the Internet including the online version. 

Note: You must be an Microsoft 365 subscriber. This is available to students 

of the University. 

Dictation works in: 

1. Microsoft Word (Office 365) 

2. Outlook (Office 365) 

3. PowerPoint (Office 365) 

4. Word Online (Office 365) 

5. Word Mobile application  

Dictation is not available in Office 2016. You should install the latest version 

from Office.com. 

How to launch 

To start dictating, you can either:  

1. click on the Dictate button on the Home tab and start speaking. 

2. use the Alt-` keyboard shortcut. 

  

Dictate button on the Home tab Dictation interface 

Available commands 

You can click on the Question mark button on the dictation interface to get a 

list of commands. 

Most common commands are: 

• Punctuation: full stop, comma, question mark 

• Document control: new line, start list, start numbered list 

• Editing: delete, backspace, bold, italics 
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Windows 

Dictation is also available in Windows 10 and Windows 11 using the same 

kind of speech recognition engine. To launch it, simply type Win-H and start 

speaking anywhere you can enter text. 

You can use this to dictate even in a Word document. 

Mac 

Dictation is also available on MacOS. See more details on how to use it: 

Dictate messages and documents on Mac – Apple Support (UK) 

Google Docs 

Dictation in Google Docs is free without any subscription. It is of similar quality 

to Microsoft Office but supports more languages. To start it, you can either: 

1. Go to Tools, select Voice Typing 

2. Use the Ctrl-Shift-S keyboard shortcut 

The commands are similar as in Microsoft Office. 

Comparing free dictation with Dragon 

Dragon is the only commercial alternative to the free dictation options. It is 

only available for Microsoft Windows. It is the only alternative for people who 

require complete voice control over their computer and/or who want to dictate 

while offline.  

Key features only available in Dragon: 

• Spell out unknown words 

• Set up a custom vocabulary 

• Train speech recognition based on own writing  

• Have full control over editing the document  

• Control any part of the computer interface with voice 

The main downsides of Dragon: 

• very high cost 

• requires some training to get the best results 

• cannot be used by different people on the same computer without 

loading a separate profile 

• is relatively resource intensive (may not work well on very slow 

computers) 

• more sensitive to signal quality (trained on particular microphone)  

Note: Dragon used to be called Dragon Naturally Speaking and Dragon 

Dictate.  

https://support.apple.com/en-gb/guide/mac-help/mh40584/mac


Page 18 of 23 

 

Works offline

Can edit existing text

Can control PC

Can be trained for own vocab

Any text input field

Expensive

No MacOS

Some training required

Dragon

Free

No training required

All platforms

Requires online connection

Limited editing

No computer control

No custom vocab

Only some applications

Google/MS
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Appendix 1: Switching to Microsoft Edge 

The new Microsoft Edge browser has built in two very useful assistive 

technologies that make it better than Chrome for reading. 

1. Read Aloud 

2. Immersive Reader 

Edge has the same engine as Google Chrome and is fully compatible with it. 

When switching to Edge, you can import all: 

1. Extensions 

2. Bookmarks 

3. Passwords 

Some additional features of Edge that may be beneficial are: 

1. Vertical display of tabs 

2. Grouping of tabs 

3. Collections of websites 

4. Icons in menus to make selection easier 

Microsoft Edge works well on: 

1. Windows (it is built in) 

2. MacOS (it can be installed alongside Safari and Chrome) 

3. Android Phones and tablets 

4. iPads and iPhones 

Read Aloud is available on all platforms. PDF reading is only on Windows and 

Mac. 

You can sync your reading across all devices. 
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Appendix 2: Listening on a mobile device 

It is often more convenient to listen to a document on a mobile device. Each 

platform has specific features or applications that enable this for free or at a 

low cost. 

All of these applications can be used while reading or simply for listening with 

a phone or tablet closed. 

iPad and iPhone 

1. Speak Screen: Feature built into iOS that can be enabled in 

Accessibility settings 

2. Acrobat Reader: Free PDF application with Read Aloud features 

3. VoiceDream Reader: Paid application designed for listening to 

documents 

4. Microsoft Edge: Can be used to listen to web pages 

Android 

1. @Voice Aloud: Free app that will enable listening to any PDF, ebook, 

or web page (supported by advertising which can be disabled for a 

small fee) 

2. Acrobat Reader: Free PDF application with Read Aloud features 

3. Moon Plus Pro: Cheap app for reading and listening to PDFs and 

eBooks 
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Appendix 3: Three best pocket guides to help with 
reading and writing strategies 

These three books are best for companions for improving your strategies for 

reading and writing. Having the right approach can  

All these books are: 

1. Pocketable and affordable 

2. Brief, to the point and practical 

3. Contain checklists and self-assessments 

They are also available as ebooks in the Oxford University library but you will 

get the most out of them, if you carry them with you in your pocket, write in 

them, and consult them often.  

1. 50 Ways To Excel At Writing by Stella Cottrell 

Handy booklet with practical tips supported by short worksheets and 

checklists that you can always keep in your pocket. It is useful to browse 

through as an eBook, but you will get more out of it if you buy a copy for 

yourself that you can write in.  

Links 

1. Check out ebook in SOLO 

2. Purchase book on Amazon 

Pros  

• Very practical with worksheets and checklists to assess your needs and 

track progress  

• User-friendly format that can be easily carried around  

• Does not require a lot of time or effort to use  

• Cheap to buy  

Cons  

• Not systematic  

• Not ideal as an eBook  

https://solo.bodleian.ox.ac.uk/permalink/f/n28kah/oxfaleph022540512
https://www.amazon.co.uk/50-Ways-Excel-at-Writing/dp/1352005883
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2. Reading and Making Notes by Jeanne Godfrey 

Essential information for students at all levels on how to improve reading 

productivity and take effective notes. It covers 10 myths of reading and 

note taking and offers practical alternatives. 

Links 

1. Check out ebook in SOLO 

2. Purchase book on Amazon 

Pros 

• Systematic approach to reading and note taking 

• Very brief; does not add additional reading burden 

• Practical tips 

• Relevant examples 

Cons 

• Vertical format makes for long-lines 

3. Writing for University by Jeanne Godfrey 

Systematic overview of the most important strategies for improving 

academic writing. Focuses on approach and developing writing skills 

rather than on structure and grammar. 

Pros 

• Systematic overview of effective writing 

• Very brief; does not add additional study burden 

• Practical tips 

• Relevant examples 

Cons 

• Vertical format makes for long-lines 

Links 

1. Check out ebook in SOLO 

2. Purchase book on Amazon 

https://solo.bodleian.ox.ac.uk/permalink/f/n28kah/oxfaleph022519194
https://www.amazon.co.uk/50-Ways-Excel-at-Writing/dp/1352005883
https://solo.bodleian.ox.ac.uk/permalink/f/n28kah/oxfaleph022540502
https://www.amazon.co.uk/Writing-University-Pocket-Study-Skills/dp/1350933678
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License 

This guide is licensed under a Creative Commons Attribution 

4.0 International License. You can share it or modify without 

asking for permission as long as you provide attribution. 

Icons and stock photos are provided under the Microsoft Premium Creative 

Content license and cannot be used or distributed outside of this document. 

http://creativecommons.org/licenses/by/4.0/
http://creativecommons.org/licenses/by/4.0/
https://support.microsoft.com/en-us/topic/what-am-i-allowed-to-use-premium-creative-content-for-0de69c76-ff2b-473e-b715-4d245e39e895
https://support.microsoft.com/en-us/topic/what-am-i-allowed-to-use-premium-creative-content-for-0de69c76-ff2b-473e-b715-4d245e39e895
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